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Welcome to the latest edition of my monthly Final Cut Studio newsletter for July, 2007.

The goal of this newsletter is to provide information helpful to the professional user
of Final Cut Pro. This newsletter publishes each month. Past issues are not
archived. However, key articles are posted on my website for your reference. All
software references are to Final Cut Studio unless otherwise noted.

Please invite your friends to visit my website -- www.larryjordan.biz. We now have
over 150 tutorials to help you get the most out of Final Cut!
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Welcome

Well, it may be the dog-days of summer, but things couldn't be busier over here. This is a mini-
version of my monthly newsletter because | just don't have time at the moment to write more.

BUT! There are some truly exciting announcements and a couple things where | really need your
help. So read on!

[ Goto Top. ]

"Improving the Final Cut Pro Interface" Contest

Last month, | created an FCP Interface contest and encouraged everyone to send in their
suggestions on how to improve the Final Cut interface.

Well, the contest was even better than | hoped - we had over 300 suggestions!

It just so happened that on Wednesday, June 27, Apple and | were both doing presentations at
the L.A. Final Cut Pro User Group meeting. They were showing off the new features in the latest
Final Cut upgrade, and | was showing how to use SmoothCam.

Mike Horton gave me a couple days warning that they were coming, so | tabulated all the results,
put them all together into a 13-page report, and formally presented it on behalf of everyone who
contributed to Paul Saccone and Brian Meaney (both of Apple) at the meeting.

I've since learned that our suggestions have been given to the entire Final Cut Pro development
team. I'm keeping my fingers crossed that we will see some of them implemented in future
versions of the software.

Thanks to everyone for their thoughts and contributions. | was surprised by the consistency of
requests and how few disagreements there were.

You can download the entire report (PDF 500KB) by clicking here. See if any of these
suggestions are on your personal wish list.

[ Goto Top. ]

Problems with QuickTime 7.2

Apple has acknowledged that there are problems with QuickTime 7.2 for some users. Here's the
link from MacWorld.

This gives me another opportunity to urge caution when upgrading to new versions of QuickTime
without also upgrading Final Cut. Final Cut is tightly coupled with QuickTime. Upgrading one


http://www.larryjordan.biz/goodies/lj_fcp_interface.pdf
http://www.macworld.com/news/2007/07/17/quicktime/index.php

without upgrading the other has been a frequent source of problems.

My general advice is that if your system is working, don't upgrade any individual elements. That
is, just because a new release of QuickTime comes out is not a good enough reason to
jeopardize your editing system by upgrading.

Rather, keep everything at the same level until you are ready to move to the next version of FCP,
then, upgrade your OS, QuickTime and FCP at the same time.

[ Goto Top. ]

Larry's Final Cut Studio Seminars Come To California and Las Vegas

It's getting close to kick-off for our latest PowerUP seminar tour. ri'ﬂ wer ™
We are traveling all over North America -- but we're only in your p _-;' L J’_] -
I -

area once! Time is running out - register now! TH FINAL CUT STUDIO

Based on dozens of seminars with hundreds of editors all over the world, we've created three
new events for this tour:

. Setting Up and Troubleshooting Your Hardware
. Optimizing Your Editing with Final Cut Studio
. Mastering Final Cut Studio

Setting Up and Troubleshooting Your Hardware is a four-hour seminar designed to configure
your computer and get it running right, selecting the right video codecs and hard disks, discover
the special challenges of working with HDV and get all your hardware questions answered.

Optimizing Your Editing with Final Cut Studio 2 is a four-hour seminar designed to answer
three questions: how do | get organized, how can | get work done faster, and how to | fix
common problems -- like poor color -- without calling Tech Support?

Mastering Final Cut Studio 2 is an eight-hour seminar that showcases the new features in Final
Cut Pro 6, shows how to create effects in Motion 3, illustrates how to improve your audio with
Soundtrack Pro 2, and covers color correction in more depth.

Register now - seats are filling quickly. August tour dates are:

. Sacramento, CA -- Aug. 10 & 11

. Las Vegas, NV -- Aug. 15 & 16

. San Diego, CA -- Aug. 23 & 24

. San Francisco, CA -- Aug. 29 & 30

Click here for detailed agendas.

Click here to reqister, or for more details.

Our initial presentation in Santa Barbara got glowing reviews. If you have questions, or to


http://www.larryjordan.biz/seminars
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http://www.larryjordan.biz/sem/2007_fall.html

arrange special billing, call: (818) 879-5105.
Tour Sponsors

By the way, I'm delighted to announce that SmartSound Software and Matrox have joined our
Tour as Gold-level national sponsors, while Automatic Duck is a Silver-level national
sponsaor.

If you haven't discovered the power SmartSound can give to your productions, you need to

check them out. I've been using them since 1997 and | couldn't be happier. They have the most
flexible music library I've ever worked with. Their new Mood Mapping technology even allows
editors to control the actual instrument mix -- without requiring any knowledge about music. Click

here to learn more.

Matrox has a new product, the MXO, that solves a key problem: how do we monitor HD video? |

reviewed it last month (click here to read the review) and was so impressed | invited them on our
Tour. Click here to learn more.

Automatic Duck makes the software that makes moving projects between Avid, Final Cut, After
Effects, ProTools and other applications possible. If you are working in a mixed-application
environment, Automatic Duck needs to be in your toolkit. Here in LA, Automatic Duck is darn
near indispensable. Click here to learn more.

Peachpit Press and Graeme Nattress have also joined us as sponsors and I'll talk about them
next month.

[ Goto Top. ]

Larry Needs Your Help
| need readers who are willing to share their stories for three projects:

1. | need editors that | can audio interview for Edit Well who are willing to share stories of
how they are using Final Cut Studio (any version) with the Edit Well audience. We've
already interviewed over 24 editors around the world and our list needs replenishing. Edit
Well covers two editors each month.

2. | need writers willing to contribute articles to Edit Well. Edit Well now reaches a world-
wide audience. If you have a story you think is worth sharing with the world, I'd like to
know about it.

3. A big-name publishing company has asked me to write a book on how to use high-
definition video in Final Cut Studio. What I'd like to include are short profiles on how
editors around the world are using high-def in their projects. What works and what doesn't.

If you are interested in helping, please click one of the links below:

1) If you are willing to participate in an audio interview describing how you are
using Final Cut Studio, click here.


http://www.smartsound.com/
http://www.smartsound.com/
http://www.smartsound.com/
http://www.matrox.com/video/products/mxo/home.cfm
http://www.matrox.com/video/products/mxo/home.cfm
http://www.automaticduck.com/
http://www.automaticduck.com/
http://www.peachpit.com/
http://www.nattress.com/
mailto:larry@larryjordan.biz?subject=Edit Well Interview

2) If you are interested in writing articles for Edit Well providing tutorials or
personal techniques that can be used by other editors, click here. You need to be

fluent in English and able to write an article at a professional level. Don't send the
story, just let me know you're interested. We'll send you all the details by return
mail.

3) If you are able to provide real-world experiences on using high-def video in
Final Cut, click here. Do NOT send your stories. This is only an expression of your

interest. We will contact you later for the interview/profile.

I'm always grateful for your feedback and I'm looking forward to talking with you further about this
in the future.

Again, don't send any materials now - we will contact you after you contact us.

[ Goto Top. ]

Comments on the Matrox MXO Review
After reading my review of the Matrox MXO, Stephen Gagné, of Ashland, Oregon, wrote:

| have two questions about things you raised in your Matrox review that | think will
also interest other readers of your newsletter. Incidentally, | checked
unsuccessfully on Matrox's forum for answers first, and also noticed that a phone
call is verboten unless one is already a registered customer:

1) You quoted Wayne saying, "The MXO supports all QuickTime-based
applications that support the V-out component, i.e. After Effects, Soundtrack Pro
and Motion." What about Shake? It's not listed in the "Not supported" list either...

2) Your review very helpfully reports an impressive list of "gotchas" regarding the
install and calibration process. Great help for someone who's mirroring your
process to not feel like they're going crazy.

Question is -- have you had any response from Wayne or others at Matrox
regarding these issues -- which if any are they planning to address in the
foreseeable? I'm sure this would be of great interest to your readers, and also a
service to Matrox, assuming they're working on at least some of them!

Larry replies: Stephen, | sent your questions to the product manager for the MXO, Wayne
Andrews, who replied:

Larry, the unit you received was from our “review” stock, so it surprised me to
learn a “read me” was not included in the box, which we do have with all official
shipping units. When you received the unit, the 2.0 drivers were not shipping yet.
All our current shipping units now include the 2.0 drivers in the box, with the
manual on the CD, and a printed release notes. The installation manual outlines
the installation procedure, and has diagrams on the connections, and also has a
procedure for calibration your DVI monitor.


mailto:larry@larryjordan.biz?subject=Interesting in writing article
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Shake is not an application that supports the V-out component of QuickTime, so it
will work only in presentation mode.

Any app that the user can define a video output, is a supported app in MXO
mastering mode.

Larry replies: Thanks, Wayne and Stephen, | appreciate all your comments.

By the way, I've found Matrox to be very responsive when | pointed out things they need to
improve - such as posting manuals to their website without requiring registration. My hope is that
this responsiveness to users will continue.

[ Goto Top. ]

This Month in Edit Well
Sigh...

The June issue of Edit Well got waylaid.

June marked the start of our second year in publishing and, to celebrate, we decided to give the
issue a redesign. It was a good idea, but bad timing.

By the time we got everyone that needed to approve it to actually approve it, three weeks had
slipped by. Then, with the issue complete and ready to go, our distribution center hit a technical
glitch.

The June issue has been complete and ready for the last week -- my hope is that by the time you
read this, it will be out. It is a KILLER issue!

. Alexis Van Hurkman writes a "must-read" article on what you need to know to run Color.
I, personally, found this a huge eye-opener.

. Then, he follows it with a simple Color workflow that anyone familiar with using the Color
Corrector 3-way filter can follow. He'll follow these two articles up next month with an
article on using curves in Color.

. Tom Meegan, an effects wizard with Final Cut, shows us techniques that he uses on
network telecasts of the NFL, MLB, NBA, NHL, and virtually every other professional
sport. | always thought Final Cut's effects were a little long in the tooth, but Tom showed
me tricks | never knew existed.

. Stephen Kanter provides an overview of the new Soundtrack Pro 2 interface, which kicks
off a three-part series from him on this new application.

. Finally, I add my two cents with an article on the secrets of using SmoothCam.

If you haven't subscribed to Edit Well yet, this is the perfect issue to start. You'll learn stuff in
here you won't find anywhere else.

Click here to read the Table of Contents.



http://www.peachpit.com/editwell
http://www.larryjordan.biz/assets/editwell/ew13_toc.pdf

Click here to subscribe: www.peachpit.com/editwell

[ Goto Top. ]

New Products in Our Store

Thinking of new software and training, we are expanding our store to provide more quality Final
Cut Studio training products.

Frankly, while I'd love to only carry my titles, | can't update my entire library in an instant. This
means you need to wait on my schedule. This delay isn't fair to you.

So, I've contacted the top training companies across the country for permission to carry their
products. Our goal is to give you immediate access to outstanding training. And when you buy
them from our store, this benefits all of us.

I'm delighted to announce that we are now carrying several Final Cut Studio training DVDs from
DV Creators. Josh Mellicker and his crew have published great training products for years. I've

worked with Josh for the last four years, teaching many of their Santa Monica training courses. |
know him and | know their company, which is why I'm pleased to offer their products in our store.

Take a look at the new titles and see if one of them can meet your needs. Click here to view our

store.

[ Goto Top. ]

Reader Mail

Well, as usual, there's no shortage of reader mail this month -- | have over 40 readers that have
written in with questions. Let's tackle some of these and save the rest for next month.

Editing in Hawalii
Marty Pickett writes in with three questions:
Aloha Larry!

Thanks for the monthly newsletters and tips. | do have three questions about FCP
and DVD Studio Pro for the newsletter.

1. In DVD-Studio Pro that comes with Final Cut Studio HD package: | am doing
wedding videos and use several menu pages. You navigate to any of the pages,
click on a button to play a Selected Scene, the video plays - | would like it to go
back to the menu/page you were on when you click stop or menu while the video
is playing. Right now mine always goes back to the Main Menu. I've tried selecting
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the current page on the Menu pane but that doesn't work.

Do you know of any way to make it go back to the page/menu you were on instead
of the Main Menu?

Larry replies: Yes, but you need to use scripts. When a button is clicked, you set a GPRM
indicating which menu the button was on. Then, when the video is done, it uses a script to
reference the value in that GPRM so it knows what menu to return to.

UPDATE - July 20, 2007
Al Williamson writes in to remind me of something | forgot:

Your reply mentioned she would need to use scripts-- however, you can do this
easily in DVDSP without scripts. If you click on the track and look in the Track
Inspector, there is a pull-down menu for Remote Control. For Menu, choose the
appropriate pull-down and navigate your way to the menu of your choice-- it
doesn't have to be the Main Menu. Extra Bonus: You can even pin-point the menu
with Chapter markers: when you click on the actual little purple Chapter Marker,
the Marker Inspector will pop up and down towards the bottom, there is a pull-
down menu for Remote Control. Using it, you can navigate your way to the menu
that corresponds to the chapter marker of your choice.

I recently did a project using this technique and when the user pressed the remote
menu button, it would jump to the menu>chapter that was designated. And | could
do this for each chapter marker-- when the track played and moved past a chapter
marker and the remote's menu button was pressed, it would always jump to the
menu point | designated, regardless of where | was in the track. IOW, it would
"know" when it was in the domain area of the chapter marker. When it passed the
next marker, it was now within it's domain and would correspond accordingly.

Larry replies: Thanks, Al, for reminding me of this. Your system is much easier.
Marty's Second Question

2. FCP-5: | made a "white" slug just like the black one that is located in the drop-
down button on the viewer. | would like to add it just below the "black slug"
selection in that drop down button. Is this possible?

Larry replies: Not below. the black slug. However, once you create the color clip you like, make
sure the Viewer is active and select Effects > Make Favorite Effect. This saves your color in the
Favorites menu AND puts it at the top of the Generators menu.
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UPDATE - July 20, 2007
Tom Wolsky provided the following:

he white slug will only appear in the Generators as long as the application's open.
If you quit and re-launch the white slug is gone from the Generators. It does
appear oddly enough in FCP in Favorites below the Motion Templates in the
Effects menu.

Marty's Third Question

3. FCP-5: | can't figure out how the make a single clip out of two or more clips on
the timeline. If | select two clips what next? | don't understand the "make
independent clip" option.

Larry replies: You can't join two dissimilar clips. Apple's manual states: "Independent clips never
share properties with other clips, no matter how many times you copy them. They are always
located in sequences. Master clips share properties with affiliate clips, and are always located in
the Browser."

So, you would make a clip independent if you wanted to make a change to the clip, for example
audio sync, that was unique to that clip and not automatically linked back to every other
occurrence of that clip.

UPDATE - July 20, 2007
Tom Wolsky offers another way to accomplish this:

You can sort of make a single clip out of multiple clips by selecting them and
pressing Opt-C (Sequence > Nest Items) to nest them.

[ Goto Top. ]




A New Way to Capture Video

Tracey Reusch, Technical Sales and Support for Adrienne Electronics Corp, sent me the
following:

| just got your newsletter and thought that you might find this short article
interesting. Let me know what you think. HUGE production savings (possible) in
time and equipment with maximum quality! MAC and FCP have never looked so
good on the production set.

http://www.adrielec.com/final cut pro quide.htm

Larry replies: Tracy, thanks for sending this. | have not heard of this before and am happy to
share the announcement with readers.

[ Goto Top. ]

"Selection Contains No Media" Error Message
Chris Roberts, Apple Trainer in the UK, writes:

Are you aware of the "Selection contains no media" error that can be encountered
when exporting a sequence from FCP 5.1.4 to Compressor 2.3? This is a problem
if you select a sequence from an open tab in the browser and choose File >
Export, or even if you select the timeline and try and export the sequence from
there if you have tabs open in the Browser. If you select the sequence from the
main project tab using the disclosure arrows for bins, or directly in the timeline
without the tab open, there doesn't seem to be a problem. Neither does this seem
to be a problem in FCP6 and Compressor 3. | had a client who flagged this up for
me (though | had seen it myself) and there seems very little info on the Internet
about it. Interesting huh?

Larry replies: Chris, | had not heard this. Thanks for sending it in.

[ Goto Top. ]

More About Handles
Jeff Coleman, of Countdown Video Productions, writes:

Larry, last month, in the "A Matter of Handles" article in your newsletter, Brian
Pshyk, from Calgary, wrote:

Every so often when | try to apply a cross dissolve between 2 clips


http://www.adrielec.com/final_cut_pro_guide.htm

(one a video clip and the other is a motion created piece) the
transition defaults to a 1 frame transition and | cannot increase its
length. The effect stays on the timeline as 1 frame in duration. Is
this a known bug?..."

This has always been a bugaboo for me. It's rarely a matter of handles in my
experience.

| find that if you lay a 30 frame center-on-edit dissolve at the transition of a clip that
has its first frame at the transition, then FCP will make that a 1 frame dissolve.
Okay, fair enough. Try to change that dissolve to longer than 1 frame it won't (and
shouldn't) let you. So try to change that dissolve to a start-on-edit dissolve (and it
should) and it won't let you (the BUG) even though there are 30 frames at the tail
of the outgoing clip and 30 frames at the head of the incoming clip.

The simplest workaround is to drag a start-on-edit dissolve onto the transition.

But if you've placed that center-on-edit dissolve on the transition and want to fix it
(rather than admitting a mistake in front of that new client you just landed), then try
this:

. After placing the dissolve, roll the transition (v r . .) 2 frames down the timeline

. Then change the dissolve type to start-on-edit

. Change the duration to xx frames (whatever you'd like and know you have handles for),
and then roll the transition (v r, ,) back up the timeline 2 frames

You'll have the dissolve you want. If | didn't have handles, | wouldn't be able to do
this. It's been that way for me since FCP 3.

Larry replies: Jeff, thanks for writing!

[ Goto Top. ]

Discussion on Color Problems
John Gallagher, newly of Scotland, writes:

| spotted you were talking about Color in the newsletter and you've got an article in
Edit Well. | spotted this article on some of the bugs and problems with Color
(which some seem to think are fairly serious if using it for intensive HD work)
courtesy of Mike Curtis of HD for Indies.

http://www.reduser.net/forum/showthread.php?t=2825

Larry replies: John, | don't normally post discussion threads from other boards, but this seemed
valuable, so I'll make an exception.

[ Goto Top. ]
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ProRes 422

Chuck Green, of Ashland, Massachusetts, writes:

N

W

I've just begun reading your new newsletter, but am bringing you a question that
arose earlier this week.

In a recent newsletter, you carried a discussion about converting HDV material to
DVCProHD after ingest and working with it in FCP in that codec. Now that FCP 6
allows mixing of codecs, and | have both DVCPro HD and HDV material to mix,
but am looking to avoid the issues of compressing the highly compressed HDV
again, four questions arise.

. Would it be advisable to work with both the HDV and DVCProHD material by converting it

all to the new ProRes codec, avoiding another compressing process?
If so, how would the conversion be done?

. Would all of the material be converted before cutting and before transitions are applied?

How does output from FCP go after the ProRes material editing is complete?

Larry replies: Chuck, these are all good questions. Here's my take on this so far.

If you are editing HDV and you are principally using cuts and dissolves, keep everything
native HDV.

If you are editing XDCAM HD (which is a variant of HDV) and you are principally using
cuts and dissolved, keep everything native XDCAM HD.

If you are integrating HDV, or XDCAM HD into sequences containing other HD material,
convert the HDV and XDCAM into that other format before editing.

If you are using heavy compositing, keying, color correction or other effects work, convert
HDV and XDCAM into ProRes before starting your edit.

At a minimum, render all HDV and XDCAM sequences using ProRes -- Sequence >
Settings > Render Control -- which will speed your renders 30 - 50%.

There is no benefit to converting DVCPRO HD into ProRes.

You convert video into ProRes either during capture using your capture card (such as the AJA IO
HD) or after capture using File > Batch Export.

By default, Final Cut will output your sequence based upon your sequence settings.

[ Goto Top. ]

More ProRes 422 Questions

Tom Burden writes:

| was reading in your newsletter about ProRes 422. Am | correct in thinking that



ProRes 422 is 10-bit color in Sd as well as HD?
Has FCP changed the rendering in FCP 67

| always thought that the plug ins and effects always rendered in 8 bit color on a
FCP timeline. Chuck Spaulding pointed out that ProRes 422 doesn't support an
alpha channel and that limited its usability. But if FCP is now supporting 10-bit
renders with ProRes 422, it is a definite improvement.

Please set me straight with FCP and the color space it is rendering at.
Larry replies: Tom, there are lots of questions here.
First, ProRes 422 works in the same color space as your video: Y'CrCb (what Apple calls YUV).

Second, ProRes is both 8- and 10-bit. When you are capturing or exporting, you can select the
bit-depth you want to use.

(By the way, bit depth is not color space. Bit-depth determines how many different shades of a
color, or luminance level, can be represented. 8-bit video displays colors and luma levels in a
range of 256 steps. 10-bit video displays colors and luma levels in a range of 1024 steps. Thus,
10-bit video will more accurately display the colors and gray scale in your image -- all other
things being equal.)

Originally, FXScript filters and transitions were 8-bit; that changed a while ago. All FXPlug filters
are 32-bit. FCP will render your sequences based upon the settings you use in Sequence >
Settings > Video processing.

Sequence Settings

Name: |Sequence 1

Ganeral ! Viseo Processing | Timeline Optians \ Render Cantral | Audia Outputs |

; Codecs which do not support YCbt
Al Rend RGE
D S E L rendering; RGE rendering may be ¢
C} Render in B-bit YLV cause intensity or color shifts in re
() Render 10-bit material in high-precision YUV High-precision YUV rendering prod
applying multiple effects, or when
5 Render all ¥UW material in high-precision ¥UWV bits of precision, but takes longer
Process Maximurn White as: | White |+j
Thiz selects how RGE colors are mapped into ¥CrCh image processing. This option can be =
which preduce "brighter than standard” white (also known as super-white].

You can only render 8-bit sequences in either 8-bit or high-precision. You can render 10-bit video
sequences in 8-bit, 10-bit, or high-precision. High-precision is better for most compositing, but
takes longer to calculate.

[ Goto Top. ]



Final Thoughts on ProRes
Chris Cummings writes:

Thanks for your terrific newsletter as always - in particular, the comments on the
new ProRes codec. As you may have seen, Creative Cow had a fantastic
summary of the codec thus far, and while I'm thrilled to have it, some of the glow
has faded the more | read into the details.

Creative Cow's recent newsletter had a fantastic article on the Sheer Video codec,
which sounds like what ProRes should have been. | know how busy you are, so
I'm not sure if you had a chance to see it...as it's a free newsletter, | extracted it
and attached it for you. | wrote Apple to lobby for native support, and hope others
will as well (perhaps Apple should have just bought Sheer Video like they did with
Color - ??)

Larry replies: Chris, thanks for mentioning this. | don't have permission to post the Cow's
newsletter, but here's a link to the Cow, herself.

[ Goto Top. ]

Video Tape Recycling
Rich "Save the VHS, Save the World" Gehron, writes:

A great resource for finding a company near you that recycles videotape and other
electronic media is the EPA. Here is a link to a page on their website:

http://www.epa.gov/epaoswer/non-hw/recycle/jtr/jtrnet/videotps.htm

ACT (Alternate Community Training) also has a recycling program here:

http://www.actrecycling.org/donations/tapes.asp

For disposing of unwanted computer media, contact Greendisk (www.greendisk.
com) You can even BUY media from them that's made from recycled material.
That should be enough to satisfy the inner tree hugger in all of us.

Larry replies: Thanks, Rich.

[ Goto Top. ]
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For Those Who Can't Get Enough Geek
Andreas Kiel, of Spherico, writes:

Larry, | got this original question came from LAFCPUG, where someone asked
how to upload a compressed file from Compressor to multiple servers.

| was about how to upload a file automatically after Compressor has finished
converting a file. After the problem had been solved using Transmit there were
some questions left open like: how to upload to multiple servers. Below my answer
which might be interesting for others as well.

Larry replies: Click here to read Andreas' entire post -- including the necessary script to get it all
to work.

The code is free, though Andreas requests a donation to a children's charity if you find this
helpful.

Andreas, thanks for sending this!

[ Goto Top. ]

A Caution About Motion

Richard Randolph writes:

What do you think of the new Retiming Behaviors in Motion. It is smooth but has
the same problem as we had before. Have you used it?

For me, the problem with retiming is that the clip that you are changing the speed
of does not become dynamic and change it's length to correctly represent the
duration of the new timed clip. This is the way it was before this update and
unfortunately it seems that it is the same now.

Larry replies: Richard, | had not noticed this. Thanks for letting me know.
UPDATE - July 20, 2007
Tom Wolsky added the following:

He's not quite right, the clip does change duration dynamically. It does get longer,
quite a bit longer if it's slowed down a lot. What does not change dynamically is
the project length. You have to manually lengthen the project duration to
accommodate the new duration of the clip. Nor does the project length
automatically ripple the sequence it was sent from inside FCP. You have to ripple
the sequence to conform to the new project length for the dynamically adjusted
clip in Motion.


http://www.spherico.com/
http://www.larryjordan.biz/articles/ak_applescript.html

Larry replies: Thanks, Tom, for this additional clarification.

[ Goto Top. ]

More Tips
Donato Rondinelli, of South Florida, writes:

| read you June 07 newsletter & was inspired by John Gallagher tips. After | picked
my jaw off the floor | too got shortcut-itis. This may be common knowledge but
here's what | discovered.

We all know that while holding down the option key you can move audio
independently from the video. So what else can you do with option & audio tracks?

Here are a few ways to get rid of the second audio track on a string of interview
bites (if the second audio track is camera the mic):

. option + drag a box around multiple clips then backspace to delete unwanted audio, or,

. option + T to select the whole track of ambient locked audio and delete, or, drum roll
please...!

. option + T, then right click on a clip (while highlighted) & uncheck clip enable. Your whole
track of camera mic a audio is disabled & the other track with a lav or boom is still
enabled & locked to the video. If you need to hear the camera mic for a clip just re-enable!

Bonus kicker: If you do it this way all you interview bites stay panned center!!! | use to
unlink the 2 tracks of audio to the video clip & delete the clips but that instantly pans your
audio R/L & you then have to adjust the pan...what a pain.

Am | the only one excited here???? :0)
One More Thing

OK, last tip, I'm getting sleepy...

VERY important tip. I've been editing over the years & on two occasions my
system drive has failed. Both times | lost my project files. Never again! EVERY
night | back up my project files this way.

When | first save a FCP project | put it inside a folder with the same name. | have
2 shortcuts on my desktop. One to my project folder & one to my back up drive.
Before | shut down each night, | open the project folder shortcut, place a letter
after the name on the folder (My Project File a.fcp) & then drag it over the backup
drive shortcut. Simple! takes a few seconds. Next night I'll change the letter on the
folder from a to b (My Project File b.fcp) & drag it over the backup drive icon.

This does 4 things:

1. backs up the project file.

2. develops a way to go back multiple days ago & open a timeline especially when
it a 15-20 day edit session. (I've needed this on occasion!)

3. keeps the hard drive clean. If you don't place the FCP project in a folder with



the same name & you rename the FCP project with something like version 2, you'll
end up with a new set of capture scratch, render, audio render file folders.

4. Keeps other project files organized...Like the After Effects projects that support
the FCP project.

That's it. Nighty night!
Thanks for everything! (including Edit Well and the Lynda tutorials)

Larry replies: Donato, thanks for all the tips. I'm a huge fan of the option key, and glad to read
that someone else has also discovered it.

[ Goto Top. ]

Well, | need to wrap up this July issue. | only got to a portion of the reader mail, but if | don't get
this out now, it won't publish until August.

Wrap-up
Well, that's it for another issue. Please take a few minutes and:

. Reqister to attend one of our PowerUP Seminars
. Subscribe to Edit Well

Your support for our seminars and products keeps our website, and this newsletter, free.

Thanks for all your comments and questions. | love hearing from you because when you share
your ideas and suggestions, we all learn.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter!

Email:

Go
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Legal Notes
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The newsletter is free -- but does require a subscription. Please invite your friends
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list
is not sold, rented, or bartered. The only person who knows you are on this list is
me.

The information in this newsletter is believed to be accurate at the time of
publication. However, due to the variety of possible system and software
configurations, the author assumes no liability in case things go wrong. Please use
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This
newsletter has not been reviewed or sanctioned by Apple or any other third party.
All trademarks are the property of their respective owners and are mentioned here
for editorial purposes only.

Text copyright 2007 by Larry Jordan & Associates, Inc. All rights reserved. This
newsletter may not be reproduced or published in any way, in whole or in part,
without specific written permission from the author.

Links to my website home page or articles are welcome and don't require prior
permission.
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